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W 
ell what do you know! Andy is now president, and I am treasur-
er. At least for the next year.  So I will stop whining for now. 
    These are surreal times. I have stopped listening to the news 
except for traffic and weather unless something is going on lo-

cally. I can usually get all of that info on the internet so I don't even have to 
pay attention for that. The rhetoric has become so vile and scary I just canôt 

stand it. Have we really become so barbaric and uncivil? 
    On another note, we are preparing at last to get Office 365.  
Backups of data are all that we need, I think. When I worked, I 
backed up my computer every day ð sometimes twice if there 
was a software update or some other event. Now not so much.  
I often feel I don't have much on the computer. I am sure many 
people feel the same way. I promised not to whine, and here I 
am.  Sorry. So anyway, to decide how to do it and get it done. 
Andy is doing very well with his hip replacement now that he 

is on a different pain med for the nerves to his knees. Can he go back to work 
now, doctor? Oh he can't drive yet, OK. He's getting bored. I expected that 
would happen as he felt better. I hear Craig is improving well with his knee 
replacement, too. The things surgeons can do now. Today I read that a robotic 
surgeon is or will be doing some eye surgeries! Wow! 
Have a good summer, and Iôll see you next month with the treasurerôs re-

port. 
ð Lisa Toth 
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Attendance at the  

June general meeting:  

34 members and guests.  

 

 

How to contact us 
The Outer Edge 
ééééé....jweigle@vcnet.com 
General Info (Ventura County  
Computers)..............805-289-3960 
Mailing Address: P.O. Box 51354, 

Oxnard, CA 93031-1354 
Email addresses for board members are 

on page 2 
On the Web: cipcug.org 
On Facebook: Facebook.com/groups/cipcug 
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Election results  
Last monthôs election went as ex-

pected. There were no nominations from 
the floor, so the slate listed in last monthôs 
TOE was elected. 
The results: 
President: Andy Toth 
Vice president/program chairman: 

Craig Ladd 
Secretary: Bob Dinsmore 
Treasurer: Lisa Toth.  
All other CIPCUG positions are ap-

pointed by the president or the board.  

Next meeting: Saturday,  
July 28 (fourth Saturday) 

 

Toth  
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The Amazon Fire Cube will be the subject of Michael 
Shalkeyôs July program on July 28 at the Boys & Girls Club of 
Camarillo, 1500 Temple Ave. (Ponderosa Drive and Temple Ave-
nue), Camarillo (map on page 20).  
The meeting starts at 8:45 a.m. with the first Q&A session, 

followed by a business meeting, the second Q&A session, a coffee 
and doughnuts break and the program. 
Dates of other coming meetings: 
Aug. 25 
Sept. 22 
Oct. 27 
Nov. 17 (third Saturday) 
Dec. 15 (third Saturday) 

SIGs  
Special Interest Groups (SIGs) are sponsored by CIPCUG and, 

when offered, are led by volunteer club members. The SIGs are 
free to CIPCUG members.  
At the moment, no SIGs are being offered. Anyone interested 

in leading a SIG or who has suggestions for one should tell any 
board member.  
Be sure to check the calendar on cipcug.org for updates on 

event programs, dates and times.  
As stated many times before, anyone who has ideas for a pro-

gram or SIG should contact any member of the board and pass the 
information on. 

Door prizes  
We have two types of raffle tickets: one for prizes offered by 

the presenter and one for club-provided prizes. The tickets for the 
presenterôs prizes are free and limited to one per member. We 
have few outside speakers these days, so these tickets donôt 
show up as often as they once did. 

The tickets for the club-provided prizes are $1 each, $5 for six 
tickets, $10 for 13 tickets, $15 for 20 tickets and $20 for 27 tickets 
and are available to anyone. Those who canôt stay until the 
drawing may sign their tickets and give the person selling the 
tickets a list of the prizes they would like in the order theyôd pick 
them. Winnersô prizes will be held until the next meeting. 

Consignment table  
A consignment table is set up at every meeting. Anyone can 

buy, but only members can sell.  

The club gets 10 percent of the sales price. Sold items must 
be picked up at the end of the dayôs meeting.  

Any items not picked up will become the property of CIPCUG 
and will be subject to disposal at the clubôs discretion. 

CIPCUG is not responsible in any way for items bought or 
sold at the table. Each item is sold as-is unless otherwise stated. 

Julyõs program will be  

Amazon Fire Cube  I 
f you need to make some personal maps for local trips 
or cross-county journeys, member John Norbutas pro-
vides lots of help in an article starting on page 14. He 
shows how to use Bing Maps (https://www.bing.com/

maps) and Google Maps (https://maps.google.com ) to cre-
ate a simple map to get from your home to the CIPCUG 
meeting site or directions for a long trip with many stops 
along the way. Of course, you can buy a paper map or visit 
AAA if youôre a member, but creating your own maps lets 
you show alternate routes, and include all kinds of notes. 
Enjoy your trip(s). 

Whatôs missing? 
I donôt know if I misplaced the email with the treasur-

erôs report, it didnôt get sent or it was considered spam by 
some email provider, but I donôt have it, and Andyôs com-
puter was in the shop at deadline time so he couldnôt send it 
again. 

    We have money, but a bit less than before 
because I submitted the TOE printing costs 
to Andy at the last meeting. Weôre not rich, 
Iôm sure, but weôre not in the ñabout to dieò 
stage either. The report should be back in the 
next issue. 
    Some of the questions and answers from 
the Q&A sessions and the program are not 
included in this monthôs reports because of 
strange sound problems. The recording of 
the meeting had many spots of silence. My 

handwriting is getting worse and worse (it was never 
great), and I depend on the recording to pick up what I 
canôt read or didnôt fully understand. I donôt remember any 
long silences during the meeting. I donôt know if the re-
cording device is fading in and out, the microphones were-
nôt close enough to  the speakersô mouths or something 
else. Iôm reasonably sure that my flash drive is OK because 
Ken Church listened to his copy of the recording, and it had 
the same problems. 
As I say in the introductions to the Q&A sessions and 

the program, if your questions arenôt included, Iôm sorry. 

PST and OST files 
After the meeting, Michael Shalkey told me of one way 

to remember the differences between PST and OST files in 
Outlook. 
The PST files are PERSONAL (local) .    
The OST files are OUT THERE (in the cloud). 

Just one more thing 
We filled all the elected board positions at the last 

meeting, but we still need volunteers for the officers ð 
Andy and Lisa canôt keep swapping the presidentôs and 
treasurerôs jobs forever. In an ideal world, every job, elect-
ed or appointed, would have at least one person to learn the 
job and be ready to handle the duties if someone is sick, 
vacationing or dies. Please feel free to volunteer. 
And thanks to everyone who helps set up and tear down 

tables and chairs at our  meetings. 

CIPCUG news and events  

Member explains 

how to make maps  

Coming CIPCUG events   

Editorõs 
corner  

 Weigle 
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Unless otherwise noted, Toby Scott 
answers the questions and Michael 
Shalkey handles the computer tasks. ð
Editor. 
There were many problems with the 

sound this month, but I donôt know if it 
was the recorder, the microphones or 
something else. Some questions and com-
ments could not be reconstructed, so if 
your questions or comments are not re-
ported, I apologize. The problems contin-
ued through the program, so the apology 
also applies to it.  

 

Q&A ð1 
Problem with web sites 
Q: I have Windows 7 Pro on a com-

puter at home and at work. I have Out-
look 2010, and it was easy for me to play 
podcasts on both computers, but now I 
have problems on one of them, which 
keeps asking if I want to download the 
podcast to Windows Media Player, 
which I havenôt had to do before. 
I go to the website and open the pod-

cast with Firefox. 
A: Michael Shalkey: Let me rephrase 

the question. You go to the site on one 
computer, and the podcast plays automat-
ically. You go to the site on a different 
computer, and it does not play automati-
cally.  
Youôre using Firefox on both com-

puters, but something is different in the 
two. It might be your extensions or you 
might have changed a setting in one of 
the browsers.  
We had an 85-year-old customer 

come in because he couldnôt get sound 
on any YouTube items. It turned out that 
he had turned on the mute this site setting 
in Google Chrome. I had never heard of 
that until the customer came in. 
Comment: The questioner first said 

the problems occur on Caravantolmid-
night.com but then said it was Coast to 
Coast AM.  
Michael Shalkey: It might be a secu-

rity issue that the site requires. 
Toby Scott: The anti-virus companies 

prefer that users download podcasts ra-
ther than playing them online. Doing that 
lets the anti-virus program scan the pod-
cast before it runs. I also think itôs a se-
curity setting. 

FBI router warnings 
Q: An article in The Breeze discussed 

an FBI warning on routers. Didnôt we 

talk about that a long time ago? 
A: Michael Shalkey: The FBI got 

more information and expanded the list 
of routers that could be infected consid-
erably. If you arenôt sure what to do with 
your router, go to the website of the com-
pany that made it, where there should be 
instructions. 
Toby Scott: Some of the modern 

routers let you download and install new 
software easily. Others are not so simple. 
(More information is available by 

gong to  https://www.bing.com/news/
search?
q=FBI+Warning+On+Routers&qpvt=fbi
+warning+on+routers&FORM=EWRE. 
ð Editor) 
Q: What about routers provided by 

ISPs? 
A: Michael Shalkey: Theyôre proba-

bly not the best solutions. 
Toby Scott: Iôm not a fan of ISP rout-

ers. I put my own router behind them.  
When you call ISPs for help on router 

issues, the tech often says let me sign in 
to your router to check some things. That 
back door is useful at the time for you 
and the tech, but consider that other peo-
ple might be able to find the log-in infor-
mation and get into your router, too. 
One thing you can do is unplug the 

router for 30 seconds and then plug it 
back in. 

Operaôs VPN apps 
Q We talked about VPNs and Opera 

at the last meeting and Operaôs plans to 
eliminate the free VPN for Androids and 
iOS. Theyôre still working on my devic-
es. 
A: I think the free versions have been 

deleted from the stores. 
(This comment came later but is 

moved here to keep related information 
together. ð Editor) 
Comment: I just checked the store on 

my Android phone, and the Opera VPN 
is no longer in the store. 
Q: I was using my VPN on my phone 

in a hotel last week and got a message on 
my phone that I was on an insecure site. 
A: Michael Shalkey: There are two 

types of websites, HTTP, which isnôt 
secure, and HTTPS, which is more se-
cure. 
Toby Scott: Thereôs a difference be-

tween the HTTP and HTTPS sites. The 
first one is not secure; it just means you 
have a connection. The second one is a 
site that has a certificate from a recog-

nized agency and the site is what it 
claims to be. Many people with websites 
have not spent the money to buy the cer-
tificate and pass some tests. 
Itôs not safe to go to HTTP sites, but 

if you know some such sites and are fa-
miliar with them (i.e., cipcug.org), 
theyôre safe if youôre careful. 
(These two questions were also 

moved here to keep related questions and 
answers together. ð Editor) 
Q: Coming back to the VPN: A cou-

ple of days ago there was an upgrade to 
the PIA VPN. Should I delete the old 
one? And, if so, how do I know which 
version is the newest one? 
A: Go to Add/remove programs and 

sort them by date. If you have problems, 
their tech support is good. 
Q: Which VPN was the one you 

(Toby) said you like in addition to 
Opera? 
A: PIA (https://

www.privateinternetaccess.com/). 

Using the Like button 
Q: A couple of days ago I listened to 

a podcast. I was asked if I wanted to like 
it. Does saying so really do anything? 
A: Michael Shalkey: If you hover 

your mouse over the emojis or Like 
statements, a list of the usersô names 
comes up.  
Toby Scott: If you like something, go 

ahead and click on Like. It helps people 
who post material decide if they want to 
keep posting such material or go on to 
other topics. 

Getting email through a  VPN 
Q: Last summer I was in Cape Cod 

and could not access my email with Out-
look. Going to the web didnôt help. I 
called Comcast and Spectrum, and they 
both said they donôt block it. I used 
Opera with the VPN activated and got 
through that way. 
A: Thatôs a way to avoid regional 

blocking. As weôve mentioned before, I 
can use a VPN and pick a server in the 
United Kingdom, so I can watch British 
TV. People in China donôt want to log in 
to Facebook from a server in China so 
they use a VPN to pick another server. 
Michael Shalkey: Several years ago, 

when Canadians could not see programs 
on such sites as Netflix and Hulu, they 
used a VPN with a server in the United 
States to get to the programs. They were 

(Continued on page 5) 

CIPCUG news and events  

Q&A sessions  
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willing to pay for the programs, but the 
companies were not available in Canada 
at the time. 

Losing email accounts 
 Q: I had Verizon Fios, and my mail 

service was moved to AOL. Verizon 
sold its cable to Frontier. I still have an 
AOL address. If I drop Frontier, does 
my e-mail go away? 
A: Michael Shalkey: Probably 
Toby Scott: Iôve encouraged people 

not to use their ISP email services be-
cause of the number of sales and mer-
gers. If I were searching for a new email 
provider Iôd use Gmail or Outlook.com. 
Iôm pretty sure theyôre not going away. 

FreedomPop ads 
Q: Facebook has had several ads and 

posts about FreedomPop. Theyôre sell-
ing SIM cards. Do you know anything 
about them? 
A: I donôt know anything about 

them.  
Michael Shalkey found several re-

views that were not complimentary. 

Upgrading from XP to Windows 7 
Q: I have an old computer with XP. 

Is there any way to upgrade directly to 
Windows 7 and retain some third-party 
apps? 
A: No.  
Clarification: Itôs not a third-party 

app but part of Microsoft Office. 
Toby Scott: You will need the key 

code, and we can help you find that. 
Upgrading to Windows 7 is hard. Mi-
crosoft says itôs not supported, and deal-
ers are not supposed to sell it. That 
leaves you buying copies  from sites 
such as eBay and Craigslist, where 
youôre never certain what youôll get. 

 

Business session 
The main news from the business 

session was the election. The results are 
on the first page of this issue. 

 

Q&A ð 2 
Using OneDrive 
Q: I have OneDrive but am not using 

it very much. How do I get other folders 
and documents into it? 
A: You can go to Properties and 

location in the folder you want to move 
and do it there. 
 (The following material came later 

in the session but is moved here to keep 
related information together ð Editor) 
Toby Scott: Back to OneDrive. Eve-

ry hard drive and computer is going to 
die sometime. If you donôt have dupli-
cates of the data on your computer, 
youôre going to be out of luck after the 
crash. 
People donôt think about some of the 

things they have on the computer ð 
wedding pictures, pictures of children 
and grandchildren at different ages and 
son on. Get those items into OneDrive 
or a similar program and get them onto 
the cloud. If youôre a Mac user, choose 
iDrive; if you use Google a lot, use its 
GoogleOne; and if youôre an Office user 
use OneDrive.  
The idea is to use the cloud storage 

of the company that youôre most famil-
iar with and are used to the layouts and 
toolbars. You can use any of the cloud 
storage sites.  
You can tell the cloud storage you 

choose what to sync with other devices 
so the program doesnôt try to load mas-
sive amounts of material on a 
smartphone or tablet. 
Michael Shalkey: Another reason for 

the cloud is that material in the cloud is 
readable. Holding up a 5 1/4-inch flop-
py, he said itôs hard to find computers 
that can read the floppies. And Scott 
noted that the magnetic imprint on those 
is not very strong, and most of them are 
no longer useable. 

No automatic log-ins 
Q: Firefox updated, and now Iôm 

being asked to log in to sites that used to 
let me do that automatically. 
A: Youôve lost your auto log-in or 

unknowingly changed your security 
settings  
Michael Shalkey: Or Firefox 

changed some settings. 

 Backing up to the cloud 
Q: Iôve seen the statements that we 

should back up things to the cloud. If I 
back up to OneDrive for photos and 
have the automatic backup to Google 
Photos. I understand that Google Photos 
is the master. Who takes precedent? 
A: You control what you open. If 

youôre relying on three media, the 
OneDrive is limited to 5 Gigs free, so 
you might want to use it for the photos 
and everything else on the Google 
Drive.  
Comment: I have Office 365.  
A: Then Iôd stick with it because you 

have a terabyte of space for free. Sync-
ing to the phone can be more difficult. 

Snipping tool 
Q: The Snipping tool generally saves 

to a file and I can send it as an email 
attachment. Iôm on Windows. Can I 
embed it in an email?  
A: Yes. 
Michael Shalkey: If youôre on Win-

dows 10, Shift + Windows key + S is 
like the Snipping tool, but I can go to 
email, open a message and use Ctrl + P 
to paste the picture in to the message..  
This question was asked during the 

second session but is moved here to 
keep related information together. ð 
Editor 

Copying pop-out menus 
Q: Another snip question: I was try-

ing to get a snip of a pop-out menu for 
TOE but couldnôt find a way to do it 
because the sub menu closed when I 
moved the mouse. Is there a way to do 
it? 
Michael Shalkey: The Shift + Win-

dows key + S should work because 
youôre not moving the mouse. 

Carbonite accounts 
Q: My son, who helps me with my 

(Continued from page 4) 

(Continued on page 6) 

CIPCUG news and events  

This monthôs Q&A topics 
Part 1 
Problem with web sites 
Operaôs VPN apps 
Using the Like button 
Getting email throuogh a VPN 
Losing email accounts 
FreedomPop ads 
Upgrading from XP to Windows 7 
 
Part 2  
Using OneDrive 
No automatic log-ins 
Backing up to the cloud 

Snipping tool 
Copying pop-out menus 
Carbonite accounts 
Google Photos 
Capturing more with sniping tool 
Tech support experiences 
DSL routers 
Bad frontier experience 
Screen settings and snips 
Asus Transformer difficulties 
Newsletters and MailChimp 
Magellan phone number 
Hard drive issue 
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computer issues, discovered we had 
OneDrive full of pictures. We bought 
some more space, so thatôs covered. He 
also found out that I have Carbonite, but 
the account is in my late husbandôs name. 
His email address no longer exists, but 
Carbonite expects it to be.  
A: Contact Carbonite and explain the 

problem. They should be able to help 
you. The number is 877-665-4466. 
Michael Shalkey suggested using 

GetHuman.com if youôre looking for cus-
tomer service phone numbers. A Google 
search for Carbonite support number had 
a number for an outside company that did 
not match the real one on GetHu-
man.com. GetHuman also shows the ex-
pected wait time on phone calls.. 
He also said that he doesnôt mind us-

ing the chat customer support, because 
typed messages are often easier to under-
stand than spoken ones.  

Google Photos 
Q: Do I understand this correctly? I 

have photos on an Android phone, and 
theyôre backed up on Google Photos. 
They should be safe, right?  
A: Yes. 

Capturing more with sniping tool 
Q: When I use the snipping tool, I 

canôt go below the bottom of the screen. 
Does the Windows 10 feature let you 
scroll below the bottom of the screen? 
A:  There is no solution to that. 
There is no solution to that except to 

save the entire web page {in Chrome, 
Firefox and Internet Explorer using 
Ctrl+S will allow you to save an entire 
webpage as an HTML file. In Edge you 
can only print to PDF to save the file}  
Tech support experiences 
Q: On tech support Iôve had good luck 

by asking to talk to a supervisor or some-
one who isnôt reading from a script. 
Comment: Iôve had good luck with 

Frontier tech support. 

DSL routers 
Q: Is there any use for a DSL router? 

Can it be adjusted to any use now? 
A: No. 

Bad frontier experience 
Toby Scott: Talking about Frontier, 

my son is a professor at a university, and 
during finals week, Frontier bought out 
Fios. Suddenly, he could not answer calls. 
They went directly to voice mail, which 
he could not access. Calls to his phone 
went to voice mail, but he could not get 
to them. Tech support had no idea what to 
do. His students ð not to mention him ð 
were not happy. 

Screen settings and snips 
Q: Do screen settings make any dif-

ference on snips? I can set pixel settings 
on the screen; does that affect the PNG 
files? 
A: The higher the resolution of the 

screen, the better the result should be, but 
usually this is not an issue unless you 
want to blow up a teeny bit of the screen. 
Comment: PNGs scale themselves on 

devices.  

Asus Transformer difficulties 
Q: I have an old, out-of-warranty 

Asus Transformer, and itôs sick. It runs 
for about 10 minutes and then comes up 
with a smiling face that says something 
happened and you need to restart. I canôt 
get to the point of being able to install a 
vanilla system. It has all kinds of drivers. 
A: The Transformer has a USB port. 

You should be able to reinstall from that 
if you have a bootable USB. Network 
drivers are fairly generic. 
A: Michael Shalkey: Go to Dis-

trowatch.com and download a live Linux 
ISO to a flash drive. Boot the Transform-
er to Linux. If Linux works, download the 
Microsoft media creation tool to down-
load Windows to a flash drive.  
Toby Scott: Windows 10 is very flexi-

ble. We do backups of computers when 
we work on one in the shop and always 

have several discs available for backups.   
Sometimes we meant to repurpose a 
backup disk, but it boots the old system.  
They almost always come right up.   

Newsletters and MailChimp 
Q: I do several newsletters for groups 

I belong to and am having some prob-
lems. I create the newsletters in Word and 
use MailChimp (mailchimp.com) to send 
them. Some people have said that they get 
question marks at various locations. I 
send a copy to myself, and itôs fine. 
A: Toby Scott: HTML is a text-only 

medium. Word has lots of hidden charac-
ters for formats and other things, and 
HTML does not recognize them. Copy 
the newsletter and paste it into a text edi-
tor like NoteTabPro. Paste any graphics 
youôre using into the text and send that to 
MailChimp.  
Michael Shalkey: How about using a 

PDF. 
Toby Scott: I donôt know if Mail-

Chimp can handle PDFs, but if it does, 
thatôs the best solution. Itôs kinder to send 
PDFs because not everyone has Word. 
Iôm using MailChimp to send the CIP-

CUG meeting and ñTOE is upò notices. 
Michael went to the MailChimp web-

site, and it lists PDF as one of the formats 
it handles.  

Magellan phone number 
Q: I had problems finding a number 

for Magellan. Can you find a number? 
A: The support number is 800-707-

9971. 

Hard drive issue 
Q: I want to take a drive from a dead 

computer to a different one. I got a case 
for it. When I try to use the disc, it asks if 
I want to reformat, and I say no because it 
would wipe everything out.  
A: Michael Shalkey: Try a different 

USB port. Sometimes that solves the 
problem.  
Trying a different computer also 

solves the problem sometimes. 

(Continued from page 5) 

When asking questions... 
1. When you ask a question, start by mentioning 

the operating system you have and the type of de-
vice (desktop, laptop, Android, smartphone, etc.) 
The answer to your question might depend on the 
differences in devices and operating systems. 

 
2. If youôre asking about a specific program, 

name the program. 
 

3. If youôre having trouble with a website in your 
browser, try opening the page in a 
different browser and see if that 
helps. You can have as many 
browsers as you want on your ma-
chine.  
The ones most mentioned at 

our meetings are Firefox, Chrome, 
Opera, Edge and sometimes Internet Explorer. All 
of them are free. 
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(If you have not read the note at the 
start of the Q&A sessions about sound 
problems, please do so before reading 
this. ð Editor) 
 
By John Weigle 
jweigle@vcnet.com 
Ventura County Computers is phasing 

out its mail server and moving all the 
email accounts to Directnic, and Toby 
Scott discussed the issue because one of 
the email accounts that is moving is cip-
cug.org. 
This report is based on Scottôs presen-

tation and cheat sheets, instructions on 
vccomputers.com,  and instructions pre-
pared by Directnic. 
The change was expected to be com-

pleted by July 2 and should be completed 
by the time you read this. After that date, 
the cipcug.org mail will be accessed at 
https://web100.dnchosting.com:2096/. 
Most of the first half of the presenta-

tion was on general email matters and the 
differences between Outlookôs PST and 
OST files. For this report, the order will 
be reversed. How to handle the changes 
will come first and the general discussion 
will be second. 

Why the change? 
Many of the smaller companies 

providing email services are getting out 
of the field because the problems are in-
creasing. Scott said the smaller email 
providers are facing charges that theyôre 
spammers. and that means more and 
more problems to try to solve. Itôs not 
worth the continuing battles, he said. 
The biggest email providers hate to 

deal with small companies, he said, and 
make it harder and harder for providers 
like VCC.  
Users who have only one email ac-

count will have the easiest time. They can 
use an email program (such as Outlook, 
Windows Mail, Thunderbird, among oth-
ers). They will have to choose one of the 
three interfaces ð Horde, Roundcube 
(Scottôs recommendation) and Squirrel 
Mail.  
They will need these obvious things: 

name, email address, and password, 
which will have to be typed twice to pre-
vent errors.  
The information page at Ventura 

County Computers includes this infor-
mation: 
ñIf you are accessing your email in 

Outlook or other email client like Win-
dows Mail, you should be able to do a 
simple setup. In Outlook, click on File, 
Add Account and you'll see: 

ñMost other email clients will look 
similar. You don't need to know server 
ports or other obscure items. The wizard 
will sort it all out automatically. Simply 
enter your name, the full email address as 
the username and your password. Click 
on Next and it should all sort out for you. 
ñOne word of warning: Your existing 

email, settings, contacts, calendar, etc. 
will not be migrated. You'll need to save 
your existing setup. In Outlook, you can 
click File > Open & Export > Import/
Export > Export to a file > Outlook Data 
File (PST) > click on the top item in the 
selector box (the full email address) and 
make sure the óinclude subfoldersô is 
checked > put it in a folder where you 
can find it and give it a recognizable 

name and click Finish. 
ñAfter you create your new account, 

you can open up the PST file you created 
by going to File > Open & Export > Im-
port from another program or file > Out-
look Data File (PST) > find the file you 
backed up and leave óReplace duplicates . 
. .ô checked > > Select the topmost folder 
and select "Import items into the current 
folder" and Finish. 
ñIf you are using Windows Mail, an 

older version of Outlook or another pro-
gram, you can probably figure out the 
differences in menus, but if not you can 
find explicit instructions from a Google 
Search. For Thunderbird users, there is an 
excellent tool called Mozbackup availa-
ble at http://mozbackup.jasnapaka.com/
download.php. 
DirectNIC has its own cheat sheets on 

configuring various platforms for their 
email:  iPhone, Outlook 2010 and Win-
dows Live Mail. 
Users who have several accounts 

must face some other matters: Do you 
want to continue to use your current 
email program? If so, youôll have to find 
the proper server settings for the new 
cipcug account. it wasnôt clear during the 
presentation if the changes would elimi-
nate old cipcug messages and, if so, how 
to prevent that. 
A comparison of the Mail and Calen-

dar for Windows 10 and Outlook 2016 
and 2013 are available at https://
support.office.com/en-us/article/mail-and
-calendar-for-windows-10-faq-4ebe0864-
260f-4d3a-a607-7b9899a98edc?ui=en-
US&rs=en-US&ad=US. 
A discussion of Windows Live Mail 

2012 vs;Windows 10 Mail is available at 
https://answers.microsoft.com/en-us/
outlook_com/forum/oemail-oapps/
windows-live-mail-2012-vs-windows-10-
mail/41c1a06e-7f2f-4297-830b-
d5f67d1d6497 

Email protocols; PST and .OST files 
The program began with Scott asking 

the audience if they know where their 
email is. Answers included ñon my com-
puterò and ñin the cloud.ò If those two 
answers are all you know, he asked, how 
do you back up your email? What folder 
is it in?  
Those questions led to the discussion 

of email protocols and PST and OST 

(Continued on page 8) 

How to handle changes in VCC email accounts  

This is the settings screen for the 
new cipcug.org mail page. 
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files. 
The two protocols of importance here 

are:  
ǒ Internet Message Access Protocol 

(IMAP). MAPI is the Messaging API for 
Outlook). 
ǒ Post Office Protocol 3 (POP3).  

POP3 
If you have a POP3 account, you go 

to a server and download your messages 
to the computer. After some period of 
time ð it depends on your email settings  
ð the messages are automatically re-
moved from the server. The only copy 
you have is on the computer, unless you 
do something about it. 
IMAP messages stay on the server 

unless the users delete them. If you delete 
an IMAP message on your computer, it is 
also deleted on the cloud. The master is 
in the cloud, and you can fill a lot of 
space quickly. You canôt meaningfully 
back it up because the master is in the 
cloud.  
If youôre in Outlook, you can open an 

Outlook data file. You can save a PST 
file. You can create a PST from the  
OST. Click on File, Open & Export, Im-
port/Export, Export to a File, Outlook 
Data File (PST).  When you create a fold-
er, the original is in the cloud, and a du-
plicate is on your computer. If you create 
a folder and it doesnôt go to the cloud, 
youôll never get to it again. 

Outlook files are PST and OST 
(Microsoft discusses PST and OST 

files at https://support.office.com/en-us/
article/Introduction-to-Outlook-Data-
Files-pst-and-ost-222EAF92-A995-45D9
-BDE2-F331F60E2790. 
That site says, ñCertain types of ac-

counts, such as POP accounts, store their 
information in Outlook Data Files (pst 
files). Outlook 365 accounts, Exchange 
accounts, IMAP accounts, and Out-
look.com accounts store their information 
in Offline Outlook Data Files (ost files).ò 
The PST file is the Outlook Data File; 

the OST file is the 
Offline Outlook Data 
File. These files are in 
different spots de-
pending on the com-
puter. Microsoft says 
to find these files by 
going to Outlook, 
clicking on  the File 
tab, and in the right 
pane, clicking on  Ac-
count Settings, and 
then clicking on  Ac-
count Settings. On the 
Data Files tab, click an 
entry, and then click 
Open Folder Location. 
 You should find 

them and copy them to 
someplace you can 
find them before you 
start juggling the 
email accounts if 
youôre going to do that. 
Key things to re-

member from Scottôs presentation are 
that a PST file is the master file, and itôs 
on your computer. A copy of the OST  
file is on your computer, but the master 
file is in the cloud. 
If you use Chrome, Firefox or Edge to 

access your email you need to create a 
copy of your email, contacts and calen-
dars. Best is to use Outlook, Windows 10 

Mail or Windows Live Mail to get a 
copy.  You can reference the file while 
using webmail on the new server.  After a 
while, youôll have everything up-to-date 
on the new server in your browser and 
can stop using Outlook or other program. 
Last Pass and RoboForm are good 

programs to keep contacts.   

(Continued from page 7) 

(Continued on page 9) 

Types of email 
Pop 3 
IMAP 
(related term: MAPI) 
 
Types of Outlook files 
PST 
OST 
 
 

Cheat sheets and helpl 
http://vccomputers.com/articles/

email.cfm 
h t t p s : / /

web100.dnchosting.com:2096/ 
h t t p s : / /

web100.dnchosting.com:2096/ 
Cheat sheets from Ventura County 

Computers 
 

Some terms, acronyms and more  

This is the opening screen if you go the mail website 

This is the sign-in screen on the new accounts. 
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By Nancy DeMarte 
2nd Vice President,  
The Sarasota Technology Users Group, 
FL 
March 2018 issue, Sarasota Monitor 
www.thestug.org / ndemarte (at) veri-
zon.net 
The 2017 Creators update (1709) to 

Windows 10 included several changes. 
One of my favorites is ñFiles on De-
mand,ò a new process to make files stored 
on OneDrive, the Microsoft cloud, availa-

ble on your PC and other devices. 
Anyone with a Windows 10 computer 

and a Microsoft account automatically has 
5 GB of free storage on OneDrive. If 
more space is needed, $1.99 a month will 
provide 50 GB of storage. Office 365 
subscribers have 1 TB (1000 GBs) of 
OneDrive storage. If you have files stored 
on OneDrive, you might want to consider 
Files-on-Demand to manage them. 

To set up Files-on-Demand, you must 
enable it in OneDrive. First, locate the 
OneDrive icon on your computer. It may 
be listed in the File Explorer left column, 
or it may be an icon in the notification 
area of the taskbar. If it isnôt visible in 

that area, click the upside-down V and 
look for it in the group of hidden icons 
that opens. The OneDrive icon resembles 
two white or blue clouds overlapping. If 
you still canôt find it, try using the Corta-
na search box or get it from the Microsoft 
store or Apple store. 
Right-click the OneDrive icon and 

click the Settings tab (picture on next 
page). Under Files-on-Demand, click next 
to ñSave space and download files as you 
use them.ò and click OK. The feature is 
now enabled. If you want to use Files-on-
Demand in OneDrive on other devices 
besides your computer, you need to ena-
ble it on each device.  
The goal of Files-on-Demand is to 

save space on your computer or device by 
storing files on the Internet but making 
them easily available and up to date on 
your computer and other devices. 
If you double-click a file in OneDrive, 

it downloads to your computer or device 
while remaining stored on OneDrive. 
If you right-click one or more 

(Continued on page 10) 

The maximum amount of data that 
can be stored on the new CIPCUG email 
server is 1 Gig for MAPI, so many of you 
will need to be careful about deleting old 
messages and spam. 
Editorôs note:  Toby reports that heôs 

figured out a way to keep the old server 
running so you can go back to your old 
messages and contacts in your browser.  
Your bookmarks will still work for quite 
a while longer.   

(Continued from page 8) 

More on VCC mail...  

OneDrive files on demand  
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 date    

Use speech to control PC, compose text  

OneDrive files and select ñAlways keep on this device,ò files 
will be available on both your device and OneDrive but will 
use hard drive space. 
If you want to save space on your computer, right click a 

file or folder in OneDrive and click ñFree up space.ò This 
makes new files created on other devices sync to your comput-
er. If you do not click this command, these new files will ap-
pear as online-only. 
To help you remember what the status is of files and folders 

saved in OneDrive, a new status column has been added that 
contains an icon next to each file. The screen shot in the next 
column shows how they look and what the icons mean. 
The folder next to the white cloud with a blue outline is 

stored only on OneDrive. The folders with a checkmark in a 
white circle outlined in green will download to the computer 
when opened. The small people icon means that folder is 
shared. 
The folder with the solid green circle and checkmark has 

been marked ñAlways keep on this device.ò It will use hard 
drive space. 
Although stored in OneDrive, the two folders with blue 

circular arrows are synced between OneDrive and one or more 
computers and devices. 

 
Tips: 
ǒ If you delete a file from OneDrive using File Explorer, it 

will also be deleted from your device. 
ǒ If you want to disable Files-on-Demand, go to One Drive 

Settings tab and remove the checkmark next to ñSave space 
and download files as you use them.ò When the feature is 
turned off, all your files that are synced to OneDrive will 
download to your computer and will no longer sync. 
ǒ For more information about Files-on-Demand, here is a 

useful website. Copy and paste it into the address bar on your 
browser: http://bit.ly/2p8KJAc 
It takes a little practice to get used to this new system, but 

(Continued from page 9) 

By Nancy DeMarte 
2nd Vice President, Sarasota Technology 
Users Group, FL  
October 2017 issue, STUG Monitor 
www.spcug.org 
ndemarte (at) Verizon.net 
Speak:  
Many modern devices have digital 

voice personalities that can help you find 
things or complete tasks. Some of these 
even have names, like Siri for Apple de-
vices, Alexa for Amazon Echo, and Cor-
tana for Windows. Microsoft Office and 
Windows 10 recently have added or up-
graded speech features that provide both 
text to speech and speech to text. Speak 
is a new feature that helps you proofread 

what you have typed by listening to the 
computer read it aloud. 
For example, if Iôm typing a Word 

document and want to see if my wording 
is smooth and accurate, I can use Speak 
to hear how it sounds. The Speak feature 
is also found in other Microsoft apps ð 
Outlook, PowerPoint, and OneNote. 
To use Speak,: click 

anywhere in a document. 
Then click the Review tab 
on the ribbon. In the Speech 
group, click ñRead Aloud,ò 
which opens an audio con-
trol bar. Click the right-
pointing single arrow, then sit back and 
listen. You can choose a male or female 

voice by clicking the setting icon, which 
resembles a person on the audio bar. 

Windows Speech Recognition (WSR)  
Windows has had a speech recogni-

tion feature for several years. This tool 
lets a user dictate into a microphone 
without the use of a keyboard or mouse 
and have his or her speech translated into 
text. It can be used to compose articles, 
write letters or emails, fill out forms, or 
complete other writing tasks. You can 
also use WSR to perform the basic func-
tions of a computer, like opening an app, 
selecting a word, showing a list of com-
mands, and adding punctuation. Original-

(Continued on page 11) 

More on OneDrive...  

 Speak icon 

http://bit.ly/2p8KJAc
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ly, it was difficult to set up, but the current ver-
sion is much easier to configure and use. Learn-
ing to use WSR is especially worthwhile if your 
typing skills are weak. 
You must have a microphone before setting 

up Speech Recognition. I found that a set of 
headphones with a microphone attached works 
very well. While it is also possible to find a Win-
dows microphone in the MS store, a headset or 
free-standing mic is recommended.  
Once you have a microphone plugged into 

your computer and turned on, itôs time to locate 
and set up Speech Recognition. In Windows 7, 
click Start > All Programs > Accessories > Ease 
of Access > Speech Recognition. In Win 10, type 
ñSpeechò in the Search box and choose the best match, Speech 
Recognition, which opens the Speech Configuration window, 
pictured in the next column.   

Speech Configuration Window 
There is a wizard (set of steps) to help you with setup. Click 

ñStart Speech Recognitionò to start the wizard. It will take you 
through all the steps in the order in which they are listed. 
First, you will set up the microphone for correct placement 

and volume setting. 
The speech tutorial consists of two short video tutorials that 

demonstrate the two main uses for speech recognition: ñHow to 
use WSR to get around your computerò and ñHow to use dicta-
tion with WSR.ò  These are worth watching more than once. 
In ñTrain your computer,ò you practice reading text aloud 

so that WSR can learn your vocal inflections, accent, and tone. 
This makes the transition from speech to text more accurate. 
The last step is to print a few pages of valuable commands 

that WSR recognizes, a handy list.  
While no speech recognition tool is perfect, the Windows 

version does a pretty good job, and setup is an easy, non-
threatening process.   

(Continued from page 10) 




